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Preface

* In addition to the above manuals, the following Fuji Electric Systems Co., Ltd. site offers various manuals and technical documents
associated with MICREX-SX.

URL    http://www.fesys.co.jp/eng/

Notes

1. This manual may not be reproduced in whole or part in any form without prior written approval by the manufacturer.
2. The contents of this manual (including specifications) are subject to change without prior notice.
3. If you find any ambiguous or incorrect descriptions in this manual, please write them down (along with the manual No. 
    shown on the cover) and contact FUJI.

Thank you for purchasing Fuji Electric Programmable Controller MICREX-SX Series.
Fuji Integration Tool “@E.Integrator” allows integrated control of an FA system by starting up an inverter loader, servo loader or
a programmable operation display editor from @E.Integrator as well as control of a network configured with programmable
controllers (MICREX-SX Series). This User’s Manual explains the functions and operations of @E.Integrator. Read this manual
carefully to ensure correct operation.
Regarding MICREX-SX Series, be sure to read the corresponding user’s manual listed below as well.

* In this manual, @E.Integrator is referred to simply as “integrator”.

* Microsoft, Windows are trademarks of Microsoft Corporation in the USA and other countries.
* Intel486 and Pentium are trademarks or registered trademarks of Intel Corp.

Title Manual No. Contents

User's Manual SX-Programmer Expert (D300win)
<Reference>, MICREX-SX series

FEH257 Explains the installation procedure, functions and operating
method of SX-Programmer Expert (D300win).

User's Manual SX-Programmer Standard
<Reference>, MICREX-SX series

FEH590 Explains the installation procedure, functions and operating
method of SX-Programmer Standard.



Safety Precautions

Caution : Incorrect handling of the device may result in minor injury or physical damage.

 The product CD is a CD-ROM. Never reproduce it using a audio CD player.
 Large sound volume may cause damage to the ear or audio equipment.
 Perform disk check periodically. Use of damaged floppy disk or hard disk may cause failure or malfunction of created data 

and system.
 Be sure to attach and lock certainly the connector of the loader cable because failure to do so may cause malfunction.
 Do not get dust at connectors because dust may cause malfunction or failure.
 Insert the CD-ROM, loader connector, etc. into the right direction because failure to do so may cause malfunction or failure.
 Fully check safety before modifying the program during operation, performing forced output, activating or deactivating the 

equipment, or performing other operations because failure to do so may cause mis-operation resulting in damage to the 
equipment or accident.

 Do not turn off the power during loader operation (during access to hard disk or floppy disk, during communication with the 
PLC) because to do so may cause loss of data, failure or malfunction of the product, damage to the equipment, or accident.

 Use the equipment in a software operation environment described in the manual because failure to do so may cause failure 
or malfunction.

 Upgrade the software according to descriptions in the manual.
 When unplugging the loader cable or power cable, do not hold the cord because to do so may cause failure or malfunction.
 Operate the loader in a stable place where there is no risk of dropping because failure to do so may cause accident.
 When discarding this product, handle it as industrial waste.
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Caution

Be sure to read the “Safety Precautions” thoroughly before using this product.

Even some items indicated by “Caution” may result in a serious accident.
These safety instructions provide important information.  Be sure to strictly observe them.
The items to be cared most are shown below:



Revisions

*The manual No. is printed at the bottom right of the cover of this manual.

Printed on *Manual No. Revision contents

May 2008 FEH299 First edition

Nov 2008 FEH299a Specification is added by version up.
(from previous version to V1.0.1.0)

Screen creation software (V-SFT) is supported.
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Section 1 General

1-1 What is @E.Integrator?

@E.Integrator is an FA system integration tool to control PLCs (SPH/SPB/FBC series), inverters (FRENIC VG7S series), servos
(ALPHA5 series) and programmable operation display (POD UG40/MONITOUCH V8 series) that an FA system comprises, via
a network. You can carry out loader operations such as monitoring and data settings of up to the third-level PLC system from
the PLC to which the integrator is connected.

Note: To control inverters, servos, and screen creation software using the integrator, they need to be connected to a SPH series CPU
via the SX bus.

1-1-1 Network topology control function
@E.Integrator allows you to display and edit network topology data of an entire SX system.
The network topology control function includes the following:

1) Displaying/editing network topology
2) Supporting loader connection via a network
3) Downloading/uploading network topology file (**.nwt) to/from CPU

Network topology window

System definition window

@E.Integrator

Network topology data
uploading/downloading function

Level 1

Level 2

Level 3
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1-1 What is @E.Integrator?

1-1-2 Supported networks

Item Type (supported version)

SPH system P-link NP1L-PL1 (V1133 or later)

PE-link NP1L-PE1 (V1133 or later)

Ethernet NP1L-ET1/ET2 (all versions)
NP1PM-48E/NP1PM-256E (V08 or later)

RS-485 NP1L-RS5 (all versions)

FL-net NP1L-FL1/FL2/FL3 (V1032 or later)

LE-net NP1L-LE1/LL1/LL2 (all versions)

SPB system Simplified CPU link NW0LA-RS4 (all versions)

FBC system Simplified CPU link Communication interface is included in a CPU board. (all versions)
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1-1 What is @E.Integrator?

1-1-3 System configuration control function
@E.Integrator allows you to select a desired configuration (SPH system) on the network topology window, and monitor and edit it.
The system configuration control function includes the following:

1) Displaying/editing system configuration definition
2) Starting related support tools

From the displayed system definition window, PLC loader, servo loader, inverter loader or screen creation software can be
started. Refer to “1-5 Start-up” for start each tools.

System definition window

PLC loader

Screen creation software

Servo loaderInverter loader

Double-click

Double-click

Double-click

Double-click
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1-1 What is @E.Integrator?

1-1-4 Integrator project function
Integrator project function allows you to merge the following files controlled by @E.Integrator into a file to collectively control
and save. By merging into a file, you can easily move control data from PC to PC.

Integrator project file (.znw) contains the following files:
Network topology file (.nwt)
Project files of each configuration

SX-Programmer Expert (D300win)  (.mwt)
SX-Programmer Standard  (.spj)

Image files of each configuration
User files in each configuration *

* In a user file, the following files can be contained: parameter editing files (.AP5) and positioning data editing files (A5L) of the
servo loader, function setting data (.FNC) of the inverter loader, and screen data files of the screen creation software (.U4, .V8).

* For more information about the integrator project function, refer to “Section 4 Integrator Project Function.”
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1-2 System Control using @E.Integrator

1-2-1 SPH system
You can connect a personal computer loader to configurations using up to three levels of connected networks. It is also
possible to set parameters of inverters or servos connected to SPH_CPU of each configuration via SX bus, using the network.

P-link

LE-net

Ethernet

FL-net

Communication board

ServoInverter

A

B

C

display

Programmable
operation

Config. A

Dedicated loader cable/USB

Config. C

Config. B

Config. D

(level 1) (level 2) (level 3)

(level 1) (level 2)

(level 1) (level 2)

(level 3)

PC loader A :
 Connect to CPU of Config. A with dedicated loader cable or USB
PC loader B :
 Connect to CPU of Config. A with communication board via FL-net
PC loader C :
 Connect to CPU of Config. B via Ethernet

<Connection route between PC loader A and Config. D (3 levels)>
Config. A � <Ethernet> � Config. B � <P-link> � Config. C � <LE-net> � Config. D

<Connection route between PC loader B and Config. D (3 levels)>
Config. A � <Ethernet> � Config. B � <P-link> � Config. C � <LE-net> � Config. D

<Connection route between PC loader C and Config. D (2 levels)>
Config. B � <P-link> � Config. C � <LE-net> � Config. D
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<System configuration specifications>

1-2-2 SPB system
You can perform programming and monitoring of SPB units connected to a simplified CPU link from a personal computer
loader connected to the master station.

Link station No. 01
Master station
Link station No. 00 Link station No. 0F

Simplified CPU link

RS-485 communication adapterRS-485 communication adapter

RS-485 communication
adapter

@E.Integrator

Up to 16 SPB units can be connected.

Note: @E.Integrator can only be connected to the master station. 

<System configuration specifications>

Item Type (supported version)

Supported network Simplified CPU link NW0LA-RS4 (all versions)

Supported basic unit All types (all versions)

Number of connectable network levels 1

Number of simultaneously connectable loaders 1

1-2 System Control using @E.Integrator

Item Type (supported version)

Supported network P-link NP1L-PL1 (V1133 or later)

PE-link NP1L-PE1 (V1133 or later)

Ethernet NP1L-ET1/ET2 (all versions)
NP1PM-48E/NP1PM-256E (V08 or later)

RS-485 NP1L-RS5 (all versions)

FL-net NP1L-FL1/FL2/FL3 (V1032 or later)

LE-net NP1L-LE1/LL1/LL2 (all versions)

Supported CPU

SPH300

NP1PS-245R/117R/117/74R/74/32R/32 (V1538 or later)
* The transparent communication of the servo loader or
inverter

loader is supported by software version V68 or later.

SPH2000 NP1PM-256E/256H/48E/48R (V08 or later)

SPH200

NP1PH-16/08 (V1137 or later)
* The transparent communication of the servo loader or
inverter

loader is not supported by SPH200.

Supported inverter VG7S FRN VG7S- SX (ROM: H1/2 E021 or later)

Supported servo ALPHA5 RYT-VS type (V1.6 or later), RYT-LS type (V1.6 or later)

Number of connectable network levels 3

Number of simultaneously connectable loaders 2



1-7

Section 1 General

1-2-3 FBC system
You can perform programming and monitoring of board controllers connected to a simplified CPU link from a personal computer
loader connected to the master station.

Link station No. 01
Master station
Link station No. 00 Link station No. 0F

Simplified CPU link

@E.Integrator

Up to 16 board controllers can be connected.

 * Board controllers have a built-in RS-485 port.

Note: @E.Integrator can only be connected to the master station. 

<System configuration specifications>

Item Type (supported version)

Supported network Simplified CPU link Built into CPU

Supported CPU board All types (all versions)

Number of connectable network levels 1

Number of simultaneously connectable loaders 1

1-2 System Control using @E.Integrator
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1-3-1 System requirements for running @E.Integrator

Item Specification

Personal computer IBM-AT compatible machine

CPU Intel Pentium III, 1GHz or higher

Hard disk
1.5G or more in empty area
* Free hard disk space required to install the related support tools is included.

External storage devices CD-ROM drive: At least one driver (quadruple speed or more recommended)

Memory capacity 1GB or more

Communication interfaces RS-232C port, USB, Ethernet (Note 1)

Mouse At least USB, serial, bus, or PS2 mouse should be supported.

Keyboard Japanese 106-key (A01) keyboard (Ctrl + alphanumeric)

Display Resolution: 1024*768 dots (XGA) or more is recommended

Operating system
Windows 2000 Professional (Service Pack4 or later) Japanese or English Edition

Windows XP (Service Pack1 or later) Japanese or English Edition

Other software
Internet Explorer5.01 or higher
.NET Framework2.0

Installer Windows-specific installer

Note 1: Communication interfaces are subject to the restrictions given below.
For communications using the USB port and USB cable, a USB driver should be installed.
Use the one bundled with @E.Integrator. If the one bundled with SX-Programmer Standard or SX-Programmer Expert
(D300win) has already been installed, you can use it as is.
For operating system Windows 2000, the [Device removal warning] dialog appears when the USB communications
have stopped (by CPU reset, system power OFF, etc.).  In this case, click the [OK] button.
Avoid carrying out the operations given below while online when USB or Ethernet communication is performed.

Turning PLC power OFF
Disconnecting USB cable
Batch reset of CPUs from another loader by multi-resourcing
Disconnecting network cable between PLC systems

For some USB host controller types, carrying out the operations given below from the loader (including SX control
utility) will disable recovery from unconnected state.  In this case, restart the personal computer.

Resetting CPU
Switching between working and standby sides when N:1 redundant system is set

1-3 System Requirements
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1-3 System Requirements

1-3-2 Combination of the related support tools
You can start related support tools from the system definition window of @E.Integrator.
The possible combinations of support tools and the versions are listed below.

Note1) The screen creation software can be started from the system definition window. However, to operate online, connect the
programmable operation display editor cable to the programmable operation display.

Note2) As for screen creation software, install either V-SFT or POD EDITOR. If both software are installed (include update), software
that is installed later is started. If either of one software is un-installed, the other software also cannot be started from the
@E.Integrator. In this case, re-install screen creation software.

1-3-3 Editable CPUs
CPUs that can be edited on the system definition window of @E.Integrator are listed below.

Model Type

SPH300 All CPUs are supported.

SPH300EX Not supported

SPH2000 All CPUs are supported.

SPH200 All CPUs are supported.

SPB All basic units are supported.

Board controller All CPU boards are supported.

Note: Basic units of the SPB series can be edited only in the “SX-mode” using SX-Programmer Expert or SX-Programmer
Standard.In the conventional “N-mode,” they cannot be edited.

Support tool Version

PLC loader SX-Programmer Expert (D300win) V3.4.4.0 or later

SX-Programmer Standard V2.3.5.0 or later

Invereter loader (VG7) PC Loader for FRENIC5000VG7 V2.1.0.1 or later

Servo loader (ALPHA5) ALPHA5 LOADER V1.8 or later

Screen creation software
V-SFT V5.3.0.0 or later

POD EDITOR V5.0.10.3 or later
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1-4 Installation

This paragraph explains how to install @E.Integrator in a personal computer that runs on operating system Windows XP.
For other operating systems such as Windows 2000, @E.Integrator can be installed in the same way.

Stop other application software, virus detection software, or screen savers running, if any.
While Windows is running, inserting the product CD-ROM into the CD-ROM drive automatically displays the screen shown
below.

Note: If the startup screen does not appear, carry out the procedure given below.
Execute Windows [Start]  [Run...], enter the name of the drive where the CD-ROM is inserted (:\autorun.exe), and then
click the [OK] button.

Clicking “@E.Integrator Setup” activates the installer.
Click the [Next] button to display the [License Agreement] screen.
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1-4 Installation

Selecting “I accept the terms in the license agreement” enables the [Next] button. Click the [Next] button to display the
[Destination Folder] screen.

The default destination folder is set as shown below.
To change it, click the [Change...] button to display the [Change Current Destination Folder] screen.  Select or enter any
folder name.
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1-4 Installation

After selecting the destination folder, click the [OK] button to return to the [Destination Folder] screen. Clicking the [Next]
button displays the screen to inform you that the program is ready to install.

Click the [Install] button on the screen shown below to start installation.
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During installation, the screen shown below is displayed.

1-4 Installation

When installation is completed, the screen shown below appears.
Clicking the [Finish] button to exit the operation.

* There is no need to restart the personal computer.

* To uninstall @E.Inetgrator, use [Add or Remove Programs] in Control Panel of Windows.
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1-5 Start-up

1-5-1 Starting @E.Integrator
Click the Windows [Start]  [All Programs]  [@E.Integrator] group  [@E.Integrator] to start @E.Integrator.

* The previously edited network topology is displayed on the screen.
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1-5 Start-up

1-5-2 Starting support tools
You can start support tools (PLC loader, servo loader, inverter loader, and screen creation software) other than the integrator from the
system definition window.

Double-click a module of the support tool that you want to start or execute the [Start Support Tool] command in the right-click
menu.

<Example of PLC loader> <Example of screen creation software>

      (Note)

<Example of servo loader>

* For PLC loaders, double-click or right-click a CPU module.

<Example of inverter loader> <Example of right-click menu>

If a “user file” is set in the selected module, the dialog shown below appears.

Application name to start

User file list

* When no “user file” is set in the selected module, the dialog shown above does not appear and the support tool starts.
* When a PLC loader is started, the dialog shown above does not appear and the PLC loader starts.

After selecting a file from the user file list, click the [OK] button. The support tool start and the selected user file automatically
opens.

Note: For the screen creation software, you can start the software and change screens offline. However, to operate online, connect
the programmable operation display loader cable to the programmable operation display.



2-1

Section 2 Offline Operation

2-1 Screen Layout

2-1-1 Screen layout
@E.Integrator consists of “network topology window”, “system definition window”, “products catalog window”, “message
window”, “menu bar”, “tool bar” and “status bar.”
“Network topology window”,  “products catalog window” and “message window”can be hidden or shown, or can be docked or
undocked (floated).

Tool bar Menu bar Network topology window

Products catalog window System definition window

Status bar

Message window
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Section 2 Offline Operation

2-1 Screen Layout

2-1-2 Docking window function
The network topology window, message window and products catalog window are docking windows, each of which can be
docked or undocked (floated). While being floated, it is possible to optionally change its size or display position.

To flost or dock the window, double-click the title bar of each window.

Double-click

Double-click

Floating Docking

* The docking windows can also be docked or floated in the following manners:
1) To float a docked window, click the title bar of the window, and drop and drag it to the position where you want to display it.

To dock the window, double-click the title bar of the window.
2) To float a docked window, select [Floating] in the [Window] menu.

To dock the window, select [Dockable] in the [Window] menu and then double-click the title bar of the window.

* The docking windows can be docked to any side of the screen.
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2-1 Screen Layout

2-1-3 Auto Hide function
When a docking window (network topology window, message window and products catalog window) is not used, it can be
automatically hidden and displayed as a small icon.

Click the push pin button on the title bar of each window to enable or disable auto hide mode.
 : Auto hide mode disabled (The window is always displayed.)
 : Auto hide mode enabled (The window is automatically hidden.)

A window with the auto hide mode enabled is automatically hidden when other window is selected.

Push pin buttonPush pin button

When a window with auto hide mode enabled becomes inactive, it is closed and displayed as an icon. For example, if the
network topology window is in auto hide mode, the screen becomes as shown below.

Hidden state: To display the hidden window, place the cursor here.

* Auto hide mode can also be enabled or disabled by checking or unchecking [Auto Hide] in the [Window] menu.
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2-2 Basic Operation of @E.Integrator

2-2-1 Network topology
(1) Creating a new network topology

Start @E.Integrator and execute [New] command in the [File] menu. The [Network Topology] window is displayed with a
configuration [Config 0] placed.

* Configuration

* Configuration
Configuration is a unit of system configuration of the SX series.

In the SPH series, a system that includes modules and remote I/Os connected to one SX bus is called a configuration.
In the SPB series, a system that includes expansion units and communication adapters connected to one basic unit is
called a configuration.
In the FBC series, a system that includes expansion boards, optional boards and remote I/Os connected to one CPU
board is called a configuration.
A configuration is displayed as a rectangle on the topology window by default. You can replace it with a desired image
data. For more information, refer to “(7) Configuration properties” in this section.
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2-2 Basic Operation of @E.Integrator

(2) Inserting a network
To insert a network to be used on the network topology window, use the following procedure.

Select a network insert button for a desired network on the network topology window and click the position where you want
to insert it (above or below the configuration). The network is inserted as shown below.

<To insert a network above a configuration>

Inserted network

<To insert a network below a configuration>

Inserted network

Click below
the configuration.

* Configurations that can be created on @E.Integrator are listed below.

Item Type (supported version)

SPH system P-link NP1L-PL1 (V1133 or later)

PE-link NP1L-PE1 (V1133 or later)

Ethernet NP1L-ET1/ET2 (all versions)
NP1PM-48E/NP1PM-256E (V08 or later)

RS-485 NP1L-RS5 (all versions)

FL-net NP1L-FL1/FL2/FL3 (V1032 or later)

LE-net NP1L-LE1/LL1/LL2 (all versions)

SPB system Simplified CPU link NW0LA-RS4 (all versions)

FBC system Simplified CPU link Communication interface is included in a CPU board. (all versions)

Click above
the configuration.



2-6

Section 2 Offline Operation

2-2 Basic Operation of @E.Integrator

(3) Connecting a configuration to a network
To connect a configuration to a network, use the following procedure.

Right-click a configuration to connect to a network and execute the [Property...] command in the menu.

Right-click here.

The properties dialog for the selected configuration appears.
Click the [Set] button to display the [Network Connection] dialog.

Connectable networks are shown in this field.
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2-2 Basic Operation of @E.Integrator

On the [Network Connection] dialog, select a network to connect and click the  button. The [Network Module] dialog
appears.

* 1

Enter a module No. and network No. of the communication module and click the [OK] button. The set network is displayed
as shown below.

*1 Parameters that can be set for each communication module

Network Module No. Network No.

P-link CPU No. 8 to 15 P-link station No. 0h to Fh

PE-link CPU No. 8 to 15 PE-link station No. 00h to 3Fh

FL-net CPU No. 8 to 15 FL-net station No. 01h to FEh

LE-net CPU No. 8 to 15 LE-net station No. 0 to 63

Ethernet SX bus station No. 1 to 254 IP address 0.0.0.0 to 255.255.255.255

RS-485 SX bus station No. 1 to 238 RS-485 station No. 00h to 1Fh

Simplified CPU link Unit No. 8, 9 Link station No. 00h to 0Fh

*2 Error messages when network connection is set

Error message Cause

<Module No./network No.> is not entered. Appears if no value is entered in the module No. or network No. field.

Entered value is out of range. Appears if a value out of the range is entered in the module No. or network No. field.

It is not a numerical value. Appears if anyting other than a number is entered in the module No. or network No.
field.

It is not a form of Internet Protocol address. Appears if the entered network No. is not the IP address format when the network is
Ethernet.

<Module No./network No.> overlaps. Appears if the same module No. has already been assigned in the configuratin.
Appears if the same network No. has already been assigned in the network.
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2-2 Basic Operation of @E.Integrator

After checking the network to connect (network name, module No., and network No.), click the [OK] button to display the
properties dialog for the selected configuration.
Click the [OK] button again to connect the configuration to the network.

(4) Resetting a network
To reset a network connected to a configuration, use the following procedure.

Right-click the target configuration and execute the [Property...] command in the menu. The properties dialog appears.
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2-2 Basic Operation of @E.Integrator

Click the [Set] button to display the currently connected network as shown below. Select a network to be reset and click the
 button. The selected network is moved to the [Selectable Network] field.

Click the [OK] button on the [Network Connection] dialog on the above condition to return to the properties dialog. Click the
[OK] button again to reset the network connection as shown below.
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2-2 Basic Operation of @E.Integrator

(6) Adding a configuration
To add a configuration on the network topology window, use the following procedure.

Select the configuration button and click the position where you want to add it. The properties dialog for the configuration
appears.

Click the position where a
configuration is to be inserted.

(5) Adding a network
To add a network on the network topology window, use the following procedure.

Select a network insert button for a desired network and click the position where you want to add it. The network is added.

Position where a network
is to be inserted.
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Click the [OK] button to add a configuration on the network topology window.

Added configuration

2-2 Basic Operation of @E.Integrator

Note: A configuration cannot be added on a line connected to a network as shown below.
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2-2 Basic Operation of @E.Integrator

(7) Configuration properties
To set a configuration name, specify a project and make network settings, use the following procedure.
An image file to be displayed on the network topology window can also be specified.

Right-click the target configuration and execute the [Property...] command in the menu. The properties dialog for the selected
configuration appears.

Items to set on the properties dialog are listed below.

Set item Description

Name Set a unique name within 32 single-byte characters. The following symbols cannot be use: \, /, :, *, ?, <,
>, |, and ".

Image Specify an image file to display on the network topology window. The following image formats are
supported: *.bmp, *.gif and *.jpg

Fix aspect ratio If this checkbox is checked, the image is displayed while keeping its original aspect ratio.

Project Specify a project corresponding to the configuration.
The extention of projects for SX-Programmer Expert (D300win) is "mwt." and that of SX-Programmer
Standard is ".spj".
If the project contains two or more configurations, choose one.

Network The connected network information is displayed. You can make the network settings here.
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2-2 Basic Operation of @E.Integrator

After setting all necessary items, click the [OK] button. The settings are reflected on the network topology window as shown
below.
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2-2 Basic Operation of @E.Integrator

2-2-2 Network topology window graphic specifications
(1) Network topology window
The network topology window consists of two elements as shown below: networks and configurations.

Network Configuration

Cursor

There are 8 rows by 32 columns of cells in the network topology window. One configuration can be put per cell and up to four
networks per line.

32 columns

8 rows

Max. 4 networks

One configuration

One cell
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2-3 System Configuration Definition

Double-click a configuration on the network topology window to display its system configuration definition.

System configuration definition

* The figure below shows the system definition screen on the PLC loader (SX-Programmer Expert/Standard) for the example
above.
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2-3 System Configuration Definition

2-3-1 System definition
(1) Adding a module
To add a module, select a desired module from the [Products Catalog] box, and drag and drop it.

Check the checkbox for a module to be added. The corresponding module groups are displayed in the lower part. Click 
button of a desired group to display modules that can be added.

Select a module to be added by clicking it, and drag and drop it to the module mounted at the far right. The selected module
is added to the right of the rightmost module (in the leftmost vacant slot).
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2-3 System Configuration Definition

(2) Inserting a module
To insert a module before (to the left of) the already registered module, use the following procedure.

Select a module from the products catalog box, and drag and drop it to a desired position (for the example below, drag and
drop it to the module A position to insert between modules A and B). The module is inserted to the right of module A. Module
B that was mounted there moves to the right.

A B

A B

Note: If there is no vacant slot on the base board, a module cannot be inserted.

(3) Moving a module
To move module A to the module B position, drag and drop module A to module B.

A B

AB
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2-3 System Configuration Definition

(4) Deleting a module
Click a module to be deleted and press the <Delete> key, or right-click a module to be deleted and execute the [Delete]
command. The confirmation dialog appears as shown below. Clicking the [Yes] button deletes the module. If a module is
mounted to the right of the deleted module, it moves to the left.
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(5) Adding a base board
Select a desired base board from the products catalog box, and drag and drop it below the current base board. The selected
base board is added as shown below.

2-3 System Configuration Definition

Added base board

* If you drag and drop the selected base board above the current one, it is added above the current one.

Added base board
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2-3 System Configuration Definition

(6) Adding a unit directly connected to SX bus
To add a unit directly connected to the SX bus (inverter, servo amplifier, etc.), use the following procedure.

Select a desired unit from the products catalog box, and drag and drop it below the current base board. The selected unit is
added as shown below.

Added unit
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2-4 Print-related Function

2-4-1 Printing system definitions
To print contents of system definition of each configuration, use the following procedure.

Select a configuration whose system definition is to be printed on the system definition window and execute the [Print...]
command in the [File] manu. The [Print] dialog appears.

Click the [Settings...] button on the [Print] dialog to display the [Page Setup] dialog.
After setting all necessary items, click the [OK] button to return to the [Print] dialog.
Clicking the [OK] button on the [Print] dialog starts printing.

Click this [Printer...] button to
change the printer settings.
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* Click the [Preview] button on the [Print] dialog to preview the system definition.
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2-4 Print-related Function

2-4-2 Handling image data
@E.Integrator allows graphics displayed on the network topology window or system definition window to be copied onto the
clipboard of the personal computer as image data or to be saved in a file as bitmap data.

(1) Copying an image onto the clipboard
Activate the network topology window or system definition window.
The image on the active window can be copied. In the figure shown below, the network topology window is active.

Execute the [Copy Image to Clipboard] command in the [Edit] menu. The image on the active window is copied onto the
clipboard.
The copied Image data can be directly pasted on an application such as Excel and Word.
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* You can check the image data copied onto the clipboard by using the Clipbook Viewer that is a standard on Windows.

Execute the [Run...] command in the Windows [Start] menu. The [Run] dialog appears.

Enter “clipbrd” in the [Open] field and click the [OK] button. The image data in the clipboard is displayed as shown below.
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2-4 Print-related Function

(2) Saving an image in a file
Activate the network topology window or system definition window.
The image on the active window can be saved. In the figure shown below, the system definition window is active.
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Execute the [Save Image to File] command in the [Edit] menu. The [Save As] dialog appears. After specifying the destination
folder and file name, click the [Save] button. The image data is saved in BMP format.

The saved image data
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2-5 Other Operations

2-5-1 Network settings check
To check whether the network settings of the configuration matches the system definition of that, use the following procedure.

Execute the [Network Settings Check] command in the [Tool] menu to start a check.
When it is completed, the dialog shown below appears. Click the [OK] button to exit the operation.

* The check result is displayed on the message window as shown below.

Configuration name

Network name

Result

Network name

Result

Number of errors

<Error message list>

Error message Cause and solution

The project is not found. Specify a project on the properties dialog for the configuration.

The configuration is not connected
with any network.

Specify a network on the properties dialog for the configuration.

The network module does not exist. The communication module that is designated as a network on the properties dialog
for the configuration does not exist in the system definition of the configuration.

[Link name] is illegal. The network No. of the communication module specified on the properties dialog for
the configuration does not match that in the system definition.

* For more information about configuration and network settings, refer to “2-2-1 Network topology.”
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2-5 Other Operations

2-5-2 System definition check
To check the system definition, module parameter and system property settings of the selected configuration, use the
following procedure.

Select a configuration whose system definition is to be checked and execute the [System Definition Check] command in the
[Tool] menu to start a check.

The [System definition check information] dialog appears showing the check result as shown below.

Note: If the system definition window is opened in a read only mode, you cannot perform a system definition check.
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2-5-3 Optional settings
Make the following optional settings.
Execute the [Option...] command in the [Tool] menu. The [Option] dialog appears.

(1) Generic
Click “Genetic” in the [Category] box to display the screen shown below.
Set the language and project type of the integrator.

2-5 Other Operations

Language
Choose the language of the integrator (English or Japanese). On an English version of Windows, Japanese is not available.
You need to restart the integrator for the change to take effect.

Default Project Type
Select the representation method of system definition of a configuration with no project specified.
If system definition is uploaded to a configuration with no project specified while online, CPU numbers and SX bus station
numbers are shown according to the project type selected here.

SX-Programmer Expert (D300win) (Default)  CPU numbers and SX bus station numbers in decimal
SX-Programmer Standard (MICREX-F address type)  CPU numbers and SX bus station numbers in decimal
SX-Programmer Standard  CPU numbers and SX bus station numbers in hexadecimal

(2) File Locations
Click “File Locations” in the [Category] box to display the screen shown below.

[Network topology/Integrator project]
Specify the folder that is initially displayed when a network topology file or integrator project is saved or opened.

[Project in configuration]
Specify the folder that is initially displayed by clicking the [Browse] button on the configuration properties dialog on the network
topology window when a project for a configuration is specified.

[Image of configuration]
Specify the folder that is initially displayed by clicking the [Browse] button on the configuration properties dialog on the network
topology window when an image for a configuration is specified.

[Temporary folder]
Specify the folder that is temporarily used when an integrator project is saved or opened.
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2-5 Other Operations

(3) Application Information
Click “Application Information” in the [Category] box to display the screen shown below.

Application information includes application names that can be used in combination with the integrator as well as folder
names where they are installed.
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3-1 Communication Setting

Set the method for communication between @E.Integrator and the CPU module. The following four communication methods
are available.

Method to use COM port of a personal computer
Method to use modem
Method to use communication board
Method to use USB

Execute the [Communication Setting...] command in the [Tool] menu. The [Communication Setting] dialog appears.

Sets the time to wait for response from a connected device (CPU module, modem, etc.) in units
of ms.  If no response is sent from the connected device even when the set time has elapsed,
the processing for retry is executed.  If no response is sent nevertheless, “Timeout” is
displayed.  As a result, the total monitoring time of response is “the set value of [Timeout] x 2”.

After setting all necessary items, click the [OK] button to complete the communication settings between the integrator and
the CPU module.
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3-1 Communication Setting

3-1-1 How to set individual interface
(1) When COM port is used
Click the [COM] button in the Communication Port box to enable the COM port setting.

Select a COM port number to coincide with
that of personal computer to be used.

*

* Clicking the [Port setting] button displays the current setting status as shown below.
When communicating with the CPU, “Bits per second” is fixed to 38400, “Data bits” to 8, “Parity” to Even, “Stop bits” to 1, and
“Flow control” to None, respectively.

If an invalid COM port number is selected, the following error message appears.
Check the settings of the personal computer and select valid one.
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(2) When modem is used
Click the [Modem] button in the Communication Port box to enable the modem setting.

*

Select a modem to be used.

Used to set the properties of the modem.

Enter a telephone number of the other side of
communication and click the [Register] button to
register it. Up to ten numbers can be registered.

Select type of the telephone
that is connected to the modem.

Note: If an error occurred during communication via modem, adjust the setting of the modem, using the following procedure:
1) Click the [Modem property...] button on the [Communication setting] dialog box to open the [Modem property] dialog

box.
2) On the [General] tab window, set maximum speed to “19200”.
3) On the [Connection] tab window, click the [Detail] button to display the [Detail Setting of Connection] dialog box. On

this dialog box, uncheck the [Zip Data] box.

* If error still recurs, decrease the maximum speed to 9600 or less.

(3) When communication board is used
Click the [Communication Board] button in the Communication Port box to enable the communication board setting.

Select a communication board to be used.

Depending on the communication board to be
used, it may be necessary to set parameters.

<Parameter setting list>

Board name Required parameter setting

SX bus board Parameter setting not required

P-link board
Set P-link station number of the other side of communication.
Example: Set "15" when the P-link station number of the other side of communication is 15.

PE-link board
Set PE-link station number of the other side of communication as well as that of the local station.
Insert a space between them.
Example: Set "63 0" when station number of the other side is 63 and that of the local station is 0.

ISA bus PLC board Parameter setting not required

Ethernet
(WEB module)

Set IP address and port number (fixed to 507) of the other side of communication. Insert a space
between them.
Example: Set "192. 0. 0. 507" when IP address of the other side is 192. 0. 0. 507.

PCI bus SX bus board Parameter setting not required

PCI bus PLC board Parameter setting not required

PCI bus FL-net board Parameter setting not required

LE-net board
Set LE-net loop station number of the other side of communication.
Example: Set "63" when the station number of the other side of communication is 63.
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(4) When USB is used
Click the [USB] button in the Communication Port box to enable the USB setting.

* When USB port is used, only SPH300 series and SPH2000 series CPUs that have a USB port become the target.
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3-2 Connecting to a Configuration

3-2-1 Connecting procedure
This paragraph explains how to connect @E.Integrator to a configuration on the network topology window.

Select a configuration to which you want to connect the integrator directly.
Right-click the configuration on the network topology window to which the integrator is to be connected and execute the [Set
Connected Configuration] command in the menu. The configuration name is highlighted as shown below.

* A configuration to which the integrator is directly connected by
a loader cable, etc. is referred to as “connected configuration.”
The name of a “connected configuration” is highlighted as
shown in the left figure.

After connecting the integrator to the connected configuration, select a target configuration on the network by clicking it.
Now, connecting operation has been completed.

Connected configuration

Configuration to be connected

* It is possible to connect a configuration on up to the third-level network from the connected configuration.
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3-2-2 Checking connectable configurations
You can control configurations on up to the third-level network from the connected configuration as well as the connected
configuration while online. Connection can be established on condition that individual configuration runs normally via a
communication module as shown on the network topology window. It is possible to check configurations that can be
controlled (connected) from the connected configuration by the [Check Connectable Configuration] command.

After setting a connected configuration, execute the [Check Connectable Configuration] command in the [Online] menu to
start a check.

3-2 Connecting to a Configuration

When the check is completed, the network topology window is displayed as shown below.

Not highlighted

Highlighted in gray

Highlighted in pink

Highlight Description

Not highlighted Indicates configurations that can be controlled (connected).

Highlighted in pink Indicates configurations that are connected on the network topology window, but not connected in the
actual configuration decause the power is turned off or a cable is disconnected.

Highlighted in gray Indicates configurations that exceed the connection range (3 levels) or not connected on the network
topology window.

Highlighted in yellow Indicates configurations whose check failed to complete. For example, if the check is stopped by clicking
the [Abort] button while it is in progress, highlighted in yellow.
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3-2-3 Setting network route
When establishing a connection between a connected configuration and another one via a network, the connection route is
automatically detected under normal conditions. Therefore, you can use it without regard to the route. However, sometimes a
connection cannot be established by the automatically detected route due to a failure of a network module, etc. In such cases,
this function allows you to manually set a route to the destination configuration.

Connected
configuration

Automatically detected route
Manually set route

Configuration to be connected

After setting a connected configuration, execute the [Network Route Setting] command in the [Tool] menu. The [Network
Route Setting] dialog appears.
On this dialog, set the networks and configurations to pass through in order.
In the case of the manually-set route in the example above, set in the following order: FL-net_0  Config.1  P-Link_0 
Config.2.

Connected configuration
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After setting the route to the destination configuration, click the  button. The set route is registered as shown below.

[Delete] button
Used to delete a peace of route information registered in the [Configurations] field.

[Clear] button
Used to delete all the route information registered in the [Configurations] field at a time.

* To change route of a configuration already registered, delete the route information registered in the [Configurations] field.
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3-3-1 Starting/stopping a CPU
You can start or stop CPUs of a configuration that is placed in the status monitor mode from the integrator.

Execute the [Run] or [Stop] command in the [Online] menu. The confirmation dialog shown below appears. Clicking the
[Yes] button collectively starts or stops all the CPUs in the configuration in the status monitor mode.

Note: If an access-level password is set in the CPU, which allows you to perform status monitor but not to start/stop the CPU,
the dialog shown below appears.

If the correct password is entered: Start/stop processing continues.
If an incorrect password is entered: The above password authentication dialog is displayed again assuming that you

do not have the access right.

* For more information about the password authentication of the integrator during online operation, refer to “3-5
Password Authentication.”



3-10

Section 3 Online Operation

3-3 Online Operation

3-3-2 Network topology data
Network topology data created on the integrator can be stored in the ZIP area of a CPU module as well as saved as a network
topology file (.nwt) of the integrator.

* Network topology file has the following information:
Network topology data between configurations
Directory name where project files of configurations are stored
Support tool (Expert/Standard) by which configurations are created

* To store network topology data in the ZIP area of a CPU module, a maximum of 1944 bytes of ZIP area is used. (for 256
configurations and 32 networks)

(1) Downloading network topology data
When network topology data is stored in a CPU module, it is downloaded to the CPUs with CPU No.0 of all the configurations
within the connection range.

Execute the [Download Network Topology] command in the [Online] menu. The dialog shown below appears.

Click the [Yes] button to start downloading.

When downloading is completed, the dialog shown below appears and the result of downloading is displayed on the
message window.

Note: If a password is set in the CPU, the dialog shown below appears during download.

Enter a password and click the [OK] button to continue downloading.
Clicking the [Cancel] button stops downloading the network topology data to the target configuration and moves on to
the next operation.
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(2) Uploading network topology data
When the network topology data is written to all the configurations on the network topology window, you can display the network
topology from anywhere using a configuration to which the integrator is connected as the connected configuration.

Execute the [Upload Network Topology] command in the [Online] menu to start uploading.

3-3 Online Operation

When uploading is completed, the dialog shown below appears and the result of uploading is displayed on the message
window..

Enter a password and click the [OK] button to continue uploading.
Clicking the [Cancel] button stops uploading the network topology data and the previous network topology window is
displayed.

Note: If a password is set in the CPU, the dialog shown below appears.
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(3) Verifying network topology data
You can verify whether the currently opened network topology matches the one stored in the CPU module.

Execute the [Verify Network Topology] command in the [Online] menu to start verification.

The currently opened network topology is compared with the one stored in the ZIP area of the CPU module.

* When verification is completed, the result of verification is displayed on the message window.

Enter a password and click the [OK] button to continue verification.
Clicking the [Cancel] button stops comparison with the configuration.

Note: If a password is set in the CPU, the dialog shown below appears.



3-13

Section 3 Online Operation

3-3 Online Operation

3-3-3 Uploading system configuration definition

The integrator can read system definition from a CPU module and display it on the system definition window. This function is
useful in checking the system configuration on a personal computer without source data (original data).

Connect the integrator to a CPU module to which the system definition is uploaded and execute the [New] command in the
[File] menu. The network topology window is displayed with a configuration placed.
Then, select the configuration and execute the [Set Connected Configuration] command in the [Edit] menu. The configuration
is highlighted in green as shown below.

Double-click the configuration to start uploading the system definition from the CPU module. When uploading is completed,
the system definition is displayed in a read only mode as shown below.
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3-4 Failure Diagnosis

3-4-1 Status monitor
You can display error information of a system (configuration) connected online on the system definition window.

Display the target configuration on the system definition window and execute the [Status Monitor] command in the [Online]
menu. The status of the module is displayed.

Status information is displayed here.

If the correct password is enterd: Status monitor continues.
If an incorrect password is entered: The above password authentication dialog is displayed again assuming that you

do not have the access right.

* For more information about the password authentication during online operation of the integrator, refer to “3-5
Password Authentication.”

<Icons for status monitor>

: Fatal fault

: Nonfatal fault

: Fatal and nonfatal fault

: Module disconnected

: CPU running

: CPU at a stop

Note: If a password is set in the CPU, the dialog shown below appears.
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3-4-2 Failure diagnosis
You can perform failure diagnosis of each configuration by activating the failure diagnosis function of SX-Programmer Expert or
SX-Programmer Standard loader through the integrator. Therefore, for more information about the failure diagnosis function,
refer to the User’s Manual of each loader.

Display the target configuration on the system definition window and execute the [Failure Diagnosis...] command in the
right-click menu. The [Failure diagnosis] dialog appears.

* For more information about the failure diagnosis function, refer to the User’s Manual for each loader.
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3-5 Password Authentication

To access a password-protected CPU, password authentication is required. The MICREX-SX series supports the ordinary
password and access level password.
The integrator is applicable to both passwords. In case password authentication is required, the dialog shown below appears.
By entering a correct password, you can move on to the next operation.

<Necessary access level for online operation of the integrator>

If an access level password is set in a CPU in a configuration, necessary access rights for each online operation are listed
below.

@E.Integrator online operation Necessary access right

Downloading netwrok topology Upload - ZIP file
Download - ZIP file

Uploading netwrok topology Upload - ZIP file

Verifying netwrok topology Upload - ZIP file

Uploading system definition Upload - System definition
Upload - ZIP file

Status monitor Upload - System definition
Failure diagnosis

Starting/stopping CPU PLC control - Initial start / start / stop / reset

Failure diagnosis Failure diagnosis

* Access level settings can be changed with the [Restriction Setting] command on the [Password] dialog of SX-Programmer
Expert or SX-Programmer Standard loader.

For more information about the access level settings,
refer to the User’s Manual for each loader.
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4-1 Overview

4-1-1 Overview
When moving network topology files and the related files to another computer, @E.Integrator allows you to merge them into a
file. Such a file is called “integrator project file.”

Network topology file (.nwt)

Project file (.mwt/.spj)

* Function setting data (.FNC)

* Screen data file (.U4, .V8)

* Parameter editing file (.AP5)
Positioning data editing file (.A5L)

* To contain parameter editing file (.AP5) and positioning data editing file (.A5L) of the servo loader, function setting data (.FNC) of the
inverter loader, and screen data file of the screen creation software (.U4, .V8) in an integrator project file (.znw), they need to be
specified as “read file.”

Integrator Project File (.znw)
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4-1-2 Related files
Files that can be contained in an integrator project file (.znw) are lsited below.

* Read file

A file created or edited by a support tool that can be activated from the integrator is called “read file”.
It is necessary to make read file settings so that they can be contained in an integrator project file.

Classification Support tool File type (extension) Remark

System configuration @E.Integrator Network topology file (.nwt) Unconditionally contained

Image file of configuration Unconditionally contained

PLC SX-Programmer Expert (D300win) Project file (.mwt) Unconditionally contained

SX-Programmer Standard Project file (.spj) Unconditionally contained

Servo Servo loader (ALPHA5 LOADER) Parameter editing file (.AP5)
Positioning data editing file (A5L)

* Read file

Inverter Inverter loader
(PC Loader for FRENIC5000VG7)

Function setting data (.FNC) * Read file

Programmable
operation display

V-SFT Screen data file (.U4, .V8) * Read file

POD EDITOR Screen data file (.U4) * Read file
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4-2 Creating an Integrator Project File

Before creating an integrator project file, make user file settings.

4-2-1 User file setting
Make user file settings from the system definition window of each configuration.
This paragraph explains the setting procedure using parameter file specification of the servo loader as an example.

On the system definition window of the target configuration, select a servo module and execute the [User file setting]
command in the right-click menu or the [Edit] menu. The [User File Setting] dialog appears.

* If the target loader software is not installed in the personal computer, the [Read file setting] command is not displayed.

Click the [Add] button on the [User File Setting] dialog to display the [Open] dialog. Select a file to specify as a user file and
click the [Open] button.
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The specified file is displayed on the [User File Setting] dialog.
Click the [OK] button to complete the setting.

4-2 Creating an Integrator Project File

To reset the setting, select a user file
registered in the [User File] field and
click the [Delete] button.

The title tab of the system definition window is
marked with “*” (asterisk) which indicates that
changes have been made to the configuration.

<Effects on a user file by @E.Integrator editing operations>

Window Operation Effect

Network topology
window

Deleting a configuration User file data of the deleted configuration is deleted.

Changing a project file on the
configuration properties dialog

User file of the changed configuration is deleted.

Changing a configuration on the
configuration properties dialog

System definition
window

Deleting a module User file data of the deleted module is deleted.

Moving a module User file data is held.

Copying and pasting a module The module is pasted without a user file.

Cutting and pasting a module User file data is held.

Changing an SX bus station No. User file data is held and assigned to the changed station No.
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4-2-2 Saving an integrator project
To zip and save network topology files, image files and project files (PLC programs) assigned to configurations, and all the
user files, use the following procedure.
When the library is used in a project file for SX-Programmer Expert (D300win), it is also saved.

Exit all the loaders other than the integrator.

Then, activate the network topology window and execute the [Save As] command in the [file] menu. The [Save As] dialog
appears.

The total size of the path and file name must be 248 bytes or less.

Specify a destination folder and file name, and choose “Integrator Project File (*.znw)” for “Save as type.” Click the [Save]
button to start saving of the integrator project. When saving of the integrator project is completed, a completion message
appears. Click the [OK] button to complete the operation.

* The saving result is displayed on the message window.
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4-2-3 Reading an integrator project
Exit all the loaders other than the integrator.

Execute the [Open] command in the [File] menu. The [Open] dialog appears.

4-2 Creating an Integrator Project File

Select an integrator project file and click the [Open] button. The [Open Integrator Project] dialog appears.

“Restore original folder”
Files are extracted in a folder structure at the time of saving of the integrator project and the network topology file opens.
However, a network topology file (.nwt) is extracted and saved in a folder specified here.

“Extract specified folder” (default)
The integrator project is extracted in a specified folder and the network topolofy file opens.
Folders are created in the specified folder as shown below.
The network topology file (.nwt) is saved under the file name of the integrator project directly under the specified folder.
The library of SX-Programmer Expert (D300win) is stored in “LIBRALIES” folder under the folder where SX-Programmer
Expert (D300win) is installed.

[Browse] button

The following data are saved:
 Project files of PLC loader (.mwt/.spj)
 Parameter editing file of servo loader (.AP5)
 Positioning data editing file (A5L)
 Function setting data of inverter loader (.FNC)
 Screen data file of screen creation software (.U4, .V8)

Specified destination folder
 Integrator project file name

Image data of configurations are saved.
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4-2 Creating an Integrator Project File

Click the [Browse] button on the [Open Integrator Project] dialog to display the [Browse For Folder] dialog. Select the
destination folder and click the [OK] button.

When the destination folder is set, the [OK] button on the [Open Integrator Project] dialog becomes active.

Click the [OK] button to start reading of the file. When reading is completed, the completion message appears. Click the
[OK] button to complete the operation.

* The reading result is displayed on the message window.

* The total size of the specified folder name and
integrator project name must be 260 bytes or less
(within 260 single-byte characters).
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